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What's New? 

Last Updated: March 2011 

New Topics 
 This version of the Hindi Style Guide has gone through a major restructure. The topics included were  
 reordered in an effort to standardize and streamlined the Style Guides for all languages.  

 

Updated Topics 

The overall Style Guide content was fully updated in February 2011 as part of major Style Guide update 

project performed for all languages. 
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Introduction 

This Style Guide went through major revision in February 2011 in order to remove outdated and unnecessary 

content. 

About This Style Guide 

The purpose of this Style Guide is to provide everybody involved in the localization of Hindi Microsoft products 

with Microsoft-specific linguistic guidelines and standard conventions that differ from or are more prescriptive than 

those found in language reference materials. These conventions have been adopted after considering context 

based on various needs, but above all, they are easy to follow and applicable for all types of software to be 

localized. 

The Style Guide covers the areas of formatting and grammatical conventions. It also presents the reader with a 

general idea of the reasoning behind the conventions. The present Style Guide is a revision of our previous Style 

Guide version with the intention of making it more standardized, more structured, and easier to use as a 

reference. 

The guidelines and conventions presented in this Style Guide are intended to help you localize Microsoft products 

and materials. We welcome your feedback, questions and concerns regarding the Style Guide. You can send us 

your feedback via the Microsoft Language Portal feedback page. 

Scope of This Document 

This Style Guide is intended for the localization professional working on Microsoft products. It is not intended to 

be a comprehensive coverage of all localization practices, but to highlight areas where Microsoft has preference 

or deviates from standard practices for Hindi localization. 

Style Guide Conventions 

In this document, a plus sign (+) before a translation example means that this is the recommended correct 

translation. A minus sign (-) is used for incorrect translation examples. 

In Microsoft localization context, the word term is used in a slightly untraditional sense, meaning the same as e.g. 

a segment in Trados. The distinguishing feature of a term here is that it is translated as one unit; it may be a 

traditional term (as used in terminology), a phrase, a sentence, or a paragraph. 

References to interface elements really only refer to translatable texts associated with those interface elements. 

Example translations in this document are only intended to illustrate the point in question. They are not a source 

of approved terminology. 
 

  

http://www.microsoft.com/Language/en-US/Feedback.aspx/
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Sample Text 

बूकॊ ऩ के आठ ददन फाद जीवित मभरा व्मक्तत 

जाऩान भें बूकॊ ऩ औय सुनाभी के आठ ददन फाद याहतकमभिमों को एक जीवित व्मक्तत मभरा है. 

जाऩानी येडडमो के भुताबफक कतसुहारू भोरयमा नाभ का मह मुिक ध्िॊस हो चुके एक भकान की दसूयी भॊक़्िर से फाहय ननकारा गमा. 
उसकी हारत क्थथय फताई जा यही है रेककन िह सदभे भें है औय कुछ फोर नहीॊ ऩा यहा है. 

उसे इराज के मरए क़यीफ के एक अथऩतार भें रे जामा गमा है. 

सदभे भें है व्मक्तत 

एक याहतकभी ने सभाचाय एजेंसी एऩी को फतामा, "भुझ ेकॊ फर भें मरऩटा एक आदभी मभरा. िह फुयी तयह थका हुआ रग यहा था". 
इससे ऩहरे सभझा जा यहा था कक बायी फर्फि फायी की िजह से अफ ककसी के जीवित होने की आशा नहीॊ है. 

स्रोत: http://www.bbc.co.uk/hindi/news/2011/03/110319_japan_survivor_sz.shtml 

 

19 भाचि 2011 को यात 8 फजे तैमाय ककमा गमा. 

Recommended Reference Material 

Normative References 

Microsoft normative sources must be adhered to. Any deviation from them automatically fails a string in most 

cases. When more than one solution is allowed in these sources, look for the recommended one in other parts of 

the Style Guide. For example, adhere to Microsoft terminology available on Language Portal:  

http://www.microsoft.com/Language/en-US/Default.aspx 

Informative References 

There are no official rule books for Hindi grammar, but following are the dictionaries and grammar books are 

recommended. 

1) www.shabdkosh.com : A good online dictionary. 

2) िैज्ञाननक ि तकनीकी शब्दािरी आमोग द्िाया प्रकामशत शब्द सॊग्रह: A technical dictionary by Govt of India available 

at Commission for Scientific & Technical Terminology. 

3) http://www.websters-online-dictionary.org/Hindi/ : An online Hindi > English Dictionary. 

4) बायत सयकाय के सूचना औय प्रसायण भॊत्रारम, प्रकाशन विबाग द्िाया प्रकामशत डॉ. विजम अग्रिार की ऩुथतक 'अऩनी दहॊदी 
सुधायें ' : For Hindi Grammar. 

  

http://www.bbc.co.uk/hindi/news/2011/03/110319_japan_survivor_sz.shtml
http://www.microsoft.com/Language/en-US/Default.aspx
http://www.shabdkosh.com/
http://www.websters-online-dictionary.org/Hindi/
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Language Specific Conventions 

This part of the style guide contains information about standards specific to Hindi. 

Country/Region Standards 

Characters 

Hindi is written in the Devanagari script. Like other Indian languages, the letters in the Devanagari script are 

grouped together based on the way they are pronounced. The first 11 letters are all vowels. Then follows the 

velar, the palatal, the retroflex, the dental, and the labial consonants. This division indicates place where the 

consonants are formed. 

 

Country/region  India 

Lower-case characters n/a 

Upper-case characters n/a 

Characters in caseless 

scripts 
n/a 

Extended Latin characters n/a 

Note on alphabetical order 

Hindi is written in a Devanagari script. Hindi is normally spoken using a 

combination of 52 sounds - 10 vowels, 40 consonants, nasalisation and a kind of 

aspiration. These sounds are represented in the Devanagari script by 52 

symbols: for 10 vowels, 2 modifiers and 40 consonants. Language speakers also 

need to learn to recognize a character that traditionally represented a vowel but 

does not any longer, and four common conjunct consonants, which is actually a 

total of 57 symbols to remember to begin with. 

Total number of characters 57 

Unicode codes Hindi Unicode range is  0901 – 0970. 

Notes n/a 

Date 

 

Country/region India 

Calendar/Era Gregorian Calendar/AD 

First Day of the Week सोभिाय (Monday) 
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Country/region India 

First Week of the Year n/a 

Separator / 

Default Short Date 

Format 
DD/MM/YY 

Example 17/03/11 

Default Long Date Format dd/MM/YYYY 

Example 17/03/2011 

Additional Short Date 

Format 1 
d Month YYYY 

Example 17 भाचि 2011 

Additional Short Date 

Format 2 
n/a 

Example n/a 

Additional Long Date 

Format 1 
n/a 

Example n/a 

Additional Long Date 

Format 2 
n/a 

Example n/a 

Leading Zero in Day Field 

for Short Date Format 
yes 

Leading Zero in Month 

Field for Short Date 

Format 

yes 

No. of digits for century 

for Short Day Format 
2 

Leading Zero in Day Field 

for Long Date Format 
It is used but not necessary 

Leading Zero in Month 

Field for Long Date 

Format 

It is used but not necessary 

Number of digits for 4 
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Country/region India 

century for Long Day 

Format 

Date Format for 

Correspondence 
DD Month YYYY 

Example 17 भाचि 2011 

Notes n/a 

Abbreviations in Format 

Codes 

d is for day, number of d's indicates the format (d = digits without leading zero, dd = 

digits with leading zero, ddd = the abbreviated day name, dddd = full day name) 

M is for month, number of M's gives number of digits. (M = digits without leading 

zero, MM = digits with leading zero, MMM = the abbreviated name, MMMM = full 

name) 

y is for year, number of y's gives number of digits (yy = two digits, yyyy = four digits)  

Time 
 

बायत India 

24 hour format Yes 

Standard time format HH:mm:ss 

Standard time format 

example 
03:24:12 

Time separator Colon (:) 

Time separator examples 03:24:12 

Hours leading zero yes 

Hours leading zero example 03:24:12 

String for AM designator ऩूिािन्ह 

String for PM designator अऩयान्ह 

Notes n/a 
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Days 

Country/region: India 
 

Day Normal Form Abbreviation 

Monday सोभिाय सोभ 

Tuesday भॊगरिाय भॊगर 

Wednesday फुधिाय फुध 

Thursday गुरूिाय गुरू 

Friday शुक्रिाय शुक्र 

Saturday शननिाय शनन 

Sunday यवििाय  यवि 

 

First Day of Week: सोभिाय 
Is first letter capitalized?: n/a 

Notes: There is no capitalization in Hindi. 

Months 

Country/region: India 
 

Month Full Form Abbreviated Form Long Date Form 

January जनियी जन Same as Full Form 

February र्फयियी र्फय Same as Full Form 

March भाचि भाचि Same as Full Form 

April अप्रैर अप्रै Same as Full Form 

May भई भई Same as Full Form 

June जून जून Same as Full Form 

July जुराई जु Same as Full Form 

August अगथत अग Same as Full Form 

September मसतॊफय मसत Same as Full Form 

October अतटूफय अतटू Same as Full Form 

November निॊफय नि Same as Full Form 

December ददसॊफय ददस Same as Full Form 



 

 
11 

 

Is first letter capitalized?: n/a 

Notes: There is no capitalization in Hindi. 

Numbers 
 

Hindi Number System follows a simple pattern of repeating itself after every ten numbers, known as Decimal 

system. 

Phone Numbers 
 

Country/

region 

International 

Dialing Code 

Area 

Codes 

Used? 

Number of 

Digits – Area 

Codes 

Separator Number of 

Digits – 

Domestic 

Digit Groupings – 

Domestic 

India 91 Yes 2; 3; 4; 5; 6 n/a 9; 10; 11; 12; 

13; 14; 15; 16 

(0##) ######; (0##) 

####### (0##) 

########; (0###) ### 

###; (0###) #######; 

(0###) ########; 

(0####) ######; 

(0####) #######; 

(0####) ######## 

Country/

region 

Number of 

Digits – 

Local 

Digit 

Groupings 

– Local 

Number of 

Digits – 

Mobile 

Digit 

Groupings 

– Mobile 

Number of 

Digits – 

International 

Digit Groupings – 

International 

India 4; 5; 6; 7; 8 

 

####; 

#####; 

######; 

### ####; 

#### #### 

10 

 

0#########

#, 91-

0#########

# (calling 

from 

abroad) 

11; 12; 13; 

14; 17 

91-(0##) ######; +91-

(0##) #######; +91-

(0##) ########; +91-

(0###) ### ###; +91-

(0###) #######; +91-

(0###) ########; +91-

(0####) ######; +91-

(0####) #######; +91-

(0####) ########## 

 

Notes: n/a 
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Addresses 

Country/region: India 

 

Disclaimer: Please note that the information in this entry should under no circumstances be used in examples as 

fictitious information. 

 

Address Format:  

1. Titel/Honorific] FirstName 

 LastName 

2. [CompanyName] 

3. StreetName 

4. [AreaName] 

5. CityName,State 

6. [Country] 

7. PostalCode 

 

Example Address:  

Local Example Example Guide 

श्री अननर शभाि 
जे. जे. कॊ ऩनी मरमभटेड, 

एभ. एभ. भागि, 
बायत नगय, 

इन्दौय, भ.प्र., 

बायत 

वऩन - १२३ ४५६ 

श्री [= Title] अननर शभाि [= FirstName + 

SecondName] 

जे. जे. कॊ ऩनी मरमभटेड [= CompanyName] 

एभ. एभ. भागि [= StreetName] 

बायत नगय [= Area] 

इन्दौय, भ.प्र. [=CityName, State] 

बायत [= Country] 

वऩन - 123 456 [= PIN Code] 

 

Local Postal Code Format: XXX XXX 

 Notes: Postal codes consist of 6 digits with no separators or a space after 3 digits.   

 MiddleName is very often abbreviated and sometimes omitted.  

 Generally postal codes or PIN codes, as they are known locally, are not needed for addresses in 
major cities. However, it is better to include them for addresses in small towns or villages. 

Currency 
 

For each country/region covered by this language, provide the following, repeating the entire set for each variation 

in format: 
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Country/region India 

Currency Name रुऩमा (Rupee) 

Currency Symbol  

Currency Symbol Position The symbol is always used before figure and a space is used. 

Positive Currency Format  1.1 

Negative Sign Symbol 
For negative values, the ordinary hyphen accessible on the keyboard is 

placed before the currency symbol (no spaces) as a minus sign. 

Negative Currency Format -  1.1 

Decimal Symbol Period (.) 

Number of Digits after Decimal 3 

Digit Grouping Symbol Comma (,) 

Number of Digits in Digit 

Grouping 
3 

Positive Currency Example  123,456,789.00 

Negative Currency Example -  123,456,789.00 

ISO Currency Code INR 356 

Currency Subunit Name Paise (ऩैसा) 
Currency Subunit Symbol P 

Currency Subunit Example 100 P 

Digit Groups 
 

The following are the norms for the digit groups: 

Country/region: India 

Decimal Separator: Period (.) 

Decimal Separator Description: It is a period. 

Decimal Separator Example: 12.23 

Thousand Separator: (,) 

Thousand Separator Description: Comma 

Thousand Separator Example: 34,456 ; ₹ 62,879 

Notes: n/a 

http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
http://en.wikipedia.org/wiki/Indian_r
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Measurement Units 
 

Metric System Commonly Used?: Yes 

Temperature: Celsius 
 

Category English Translation Abbreviation 

Linear Measure Kilometer ककरोभीटय ककभी 
Meter भीटय भी 
Decimeter डसेीभीटय डभेी 
Centimeter सेंटीभीटय सेभी 
Millimeter मभरीभीटय मभभी 

Capacity Hectoliter हेतटोरीटय हेभी 
Liter रीटय री 
Deciliter डसेीरीटय डरेी 
Centiliter सेंटीरीटय सेरी 
Milliliter मभरीरीटय मभरी 

Mass Ton टन N/A 

Kilogram ककरोग्राभ ककग्रा 
Pound ऩाउॊ ड N/A 

Gram ग्राभ ग्रा 
Decigram डसेीग्राभ डगे्रा 
Centigram सेंटीग्राभ सेग्रा 
Milligram मभरीग्राभ मभग्रा 

English Units of 

Measurement 

Inch इॊच N/A 

Feet पुट N/A 

Mile भीर N/A 

Gallon गैरन N/A 

 

 Notes: When miles and pounds are used in the English document, add the conversion to km and kg, 
respectively,  in parentheses.  

For example                 5 miles   becomes     ५ भीर (८ ककभी) 
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Percentages 
 

Percentage is indicated by the following sign: % 

 

Example: व्माऩाय भें िवृि 28% है।  

Sorting 
 

Sorting rules 

In the Index section, the following sorting order is applied: 

1. Non-alphabetical characters (i.e. symbols like ! " # $ % & ( ) * , . / : ; ? @ [ \ ]) 

2. Digits (0-9) 

3. alphabetical characters 

Character 

sorting order 
n/a 

Examples of 

sorted words 

@ 

1 

अॊफय 
कभर 

िाहन 

Aaron 

andere 

ändere 

chaque 

chemin 

cote 

coté 

côte 

côté 

čučēt 

Czech 

chaque 

chemin 

hiša 

irdisch 

lävi 

lie 

lire 
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llama 

lõug 

Löwen 

lòza 

Lübeck 

luč 

luck 

lye 

Männer 

màšta 

mîr 

möchten 

myndig 

pint 

pylon 

piña 

sämtlich 

šàran 

savoir 

Šerbūra 

Sietla 

ślub 

subtle 

symbol 

verkehrt 

vox 

waffle 

wood 

yen 

yuan 

yucca 

ţal 

ţena 

Ţenēva 

zoo 

Zürich 

Zviedrija 
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zysk 

zzlj 

zzlz 

zznj 

zznz 

Geopolitical Concerns 

Part of the cultural adaptation of the US-product to a specific market is the resolving of geopolitical issues. While 

the US-product should have been designed and developed with neutrality and a global audience in mind, the 

localized product should respond to the particular situation that applies within the target country/region. 
 

Sensitive issues or issues that might potentially be offensive to the users in the target country/region may occur in 

any of the following: 

 Maps 

 Flags 

 Country/region, city and language names 

 Art and graphics 

 Cultural content, such as encyclopedia content and other text where historical or political references may 

occur 

Some of these issues are relatively easy to verify and resolve: the objective should be for the localizer to always 

have the most current information available. Maps and other graphic representations of countries/regions and 

regions should be checked for accuracy and existing political restrictions. Country/region, city and language 

names change on a regular basis and need to be checked, even if previously approved. 

A thorough understanding of the culture of the target market is required for checking the appropriateness of 

cultural content, clip art and other visual representations of religious symbols, body and hand gestures. 

 

Grammar, Syntax & Orthographic Conventions 

This section includes information on how to apply the general rules of the Hindi language to Microsoft products 

and documentation. 

Adjectives 
 

There are four types of adjectives in Hindi: 

गुण िाचक (Quality)  

सॊख्मा िाचक (Numeral)  

ऩरयभाण िाचक (Quantity)  

सॊकेत िाचक (Demonstrative) 
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Possessive adjectives 

The frequent use of possessives is a feature of English language. In Hindi too, possessive adjectives are 

frequently used. Examples are भेया (mine), तुम्हाया (your), आऩका (Your (respectfull)), उनका (their), उसका(his), 

हभाया(our). 

Articles 

General considerations 

There are no articles in Hindi language. Equally important is, there is no need to translate every A or AN used in 

English into Hindi.  

 

Example Translation 

Create a document + दथतािे़ि फनाएॉ 
- एक दथतािे़ि फनाएॉ 

 

Unlocalized Feature Names 
 

Microsoft product names and non-translated feature names are used without definite or indefinite articles in the 

English language. Microsoft product names and non-translated feature names are used as it is in Hindi. No article 

is added. 

 

Localized Feature Names 
 

Hindi does not have a definite article and indefinite articles are not used with product names in Hindi. 

Example: इस कॊ प्मूटय ऩय Windows सििय थथावऩत है। 
 

Articles for English Borrowed Terms 
 

When faced with an English loan word previously used in Microsoft products, consider the following options: 

 Motivation: Does the English word have any formally motivated features that would allow a 

straightforward integration into the noun class system of Hindi language? - None for Hindi 

 Analogy: Is there an equivalent Hindi term whose article could be used? - None for Hindi 

 Frequency: Is the term used in other technical documentation? If so, what article is used most often? 

The internet may be a helpful reference here. - None for Hindi 

Please always consult Microsoft terminology (for example, available via Language Portal: 

http://www.microsoft.com/Language/en-US/Default.aspx) to confirm the use of a new loan word and its proper 

article to avoid inconsistencies. 

http://www.microsoft.com/Language/en-US/Default.aspx
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Capitalization 
 

This section doesn’t apply to Hindi. 

Compounds 
 

This section doesn’t apply to Hindi. 

Gender 
 

All nouns in Hindi are divided into one of two grammatical types, called genders. These genders are masculine- 

ऩुक््रॊग and feminine- थत्री मरॊग. Nouns often modify other words in the sentence according to their gender. 

All male living beings are masculine. All female living beings are feminine. In the case of names of inanimate 

things and abstract, collective and material nouns, gender is determined mainly by usage.  

Masculine gender- पुल्लिंग  

Feminine gender- स्त्री ललिंग 

रड़का 
boy 

रड़की 
girl 

आदभी 
man 

औयत 

woman 

वऩता 
father 

भाता 
mother 

फेटा 
son 

फेटी 
daughter 

फच्चा 
boy baby 

फच्ची 
girl baby 

बाई 

brother 

फहन 

sister 
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अध्माऩक 

male teacher  

अध्मावऩका 
female teacher 

Genitive 

In Hindi, genitives are indicated with kaa/ke/kii as morpho-word. Choice of kaa/ke/kii depends on the gender, 

number and case ending of the head noun. Table 1 explains and illustrates the usage of kaa/ke/kii for different 

variations of head noun. 

 

TABLE 1: Usage of का/के/की in genetive case 

 

Gender of head noun Number of head noun Case-ending of head noun का/के/की Example(s) 

Masculine Singular Absent का रड़के का बाई 
Masculine Plural Absent के रड़के के बाई 
Masculine Don't care Present के रड़के के बाई ने, 

रड़के के बाइमों ने 

Feminine Don't care Don't care की रड़के की फहन, 

रड़के की फहन ने, 

रड़के की फहनों ने, 

रड़के की फहनें 

Modifiers 
 

This section doesn’t apply to Hindi 

Nouns 

General considerations 

Please follow normative rules related to nouns. 

1. व्मक्तत िाचक सॊज्ञा (Proper Noun) - e.g. दद्री, गाॊधी, याभामण, गीताॊजरी, दहभारम, ताजभहर 

2. जानत िाचक सॊज्ञा (Common Noun) - e.g. भोय (peacock), ऩुथतक (book), भदहरा (lady), फारक (boy), फामरका 
(girl) 

3. बाि िाचक सॊज्ञा (Abstract Noun) - e.g. फचऩन (childhood), सत्म (truth), सुॊदयता (beauty), नम्रता (politeness) 

4. सभुदाम िाचक सॊज्ञा (Collective Noun) - e.g. सेना (armed forces), सबा (assembly), भॊडरी (group) 

5. द्रव्म िाचक सॊज्ञा (Material Noun) - e.g. सोना (gold), रोहा (iron), ऩानी (water) 
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Inflection 

This section doesn’t apply to Hindi. 

 

Plural Formation 
 

Singular and Plural of Nouns in the Direct Case: 

Masculine: Ending in -a 

Singular: रडका = boy Plural: रडके  = boys 

Masculine: Ending in other vowel (very few): 

Singular: गुरु = teacher Plural: गुरु = teacher 

Masculine: Ending in a consonant 

Singular: दोथत = friend Plural: दोथत = friends 

Feminine: Ending in -i 

Singluar: रडकी = girl Plural: रड़ककमाॉ = girls 

Feminine: Ending in a consonant 

Singular: ककताफ  = book Plural: ककताफें  = books 

Feminine: Ending in -a or -u 

Singular: अध्मावऩका = female teacher Plural: अध्मावऩकाएॉ   = female teachers 

 

Singular and Plural of Nouns in the Oblique Case: 

Masculine: Ending in -a 

Singular: रडके Plural: रडकों  
Masculine: Ending in other vowel (very few): 

Singular: गुरु Plural: गुरुओॊ (for आदभी /man/ - आदमभमों) 
Masculine: Ending in a consonant 

Singular: दोथत Plural: दोथतों 
Feminine: Ending in -i 

Singluar: रडकी Plural: रड़ककमों  
Feminine: Ending in a consonant 

Singular: ककताफ Plural: ककताफों  
Feminine: Ending in -a or -u 

Singular: अध्मावऩका  Plural: अध्मावऩकाओॊ 
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Prepositions 
 

Pay attention to the correct use of the preposition in translations. Influenced by the English language, many 

translators omit them or change the word order. 

Hindi prepositions link nouns, pronouns and phrases to other words in a sentence. The word or phrase that the 

preposition introduces is called the object of the preposition. Hindi (like other Indian languages) uses 

postpositions instead of prepositions. Postpositions are like prepositions except that they are written after the 

noun. 
 

US Expression Hindi Expression Comment 

about के बारे में n/a 

after के बाद n/a 

behind के पीछे n/a 

before से पहले n/a 

Pronouns 
 

Pronouns in Hindi are called “सििनाभ”.  

 

There are five main types of pronouns in Hindi: 

1. Personal Pronouns, known as ऩुरुष िाचक सििनाभ 

2. Demonstrative Pronoun, known as ननश्चम िाचक सििनाभ 

3. Indefinite Pronoun, known as अननश्चम िाचक सििनाभ 

4. Relative Pronoun, known as सॊफॊध िाचक सििनाभ 

5. Interrogative Pronoun, known as प्रश्न िाचक सििनाभ 

 

Known Issue: It’s a common error to use आऩ आऩके खात,े हभ हभायी र्फाइर को..., etc. It should be always आऩ अऩने, 
हभ अऩने, and िो अऩने. Please keep this in mind.  

 

Punctuation 

Comma 

In Hindi the sign of comma is the same as in English.  

 

Colon 

In Hindi the sign of colon is the same as in English. 
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Dashes and Hyphens 
 

Hyphen 

The hyphen is used to divide words between syllables, to link parts of a compound word, and to connect the parts 

of an inverted or imperative verb form. In Hindi also the sign of hyphen is the same as that in English. 

Example: अरग–अरग 

 

Ellipses (Suspension Points) 

 

This section doesn’t apply to Hindi 

 

Period 
 

The end of a sentence is indicated in Hindi by a vertical line “ | ” . All the other punctuation marks are used in 

Hindi just as they are in English. 

 

Quotation Marks 
 

Quotation marks are used when you want to emphasize something. 

In US source strings, you may find software references surrounded by English quotation marks. Same for Hindi. 

 

Parentheses 
 

In English, there is no space between the parentheses and the text inside them. Same for Hindi. 

Example: 5 भीर (8 ककभी) 

Singular & Plural 
 

Plural and Singular have a very important role in Hindi, therefore they need very special attention. 

Example: ऩुथतक Singular ऩुथतकें  Plural  

फच्चा Singular  

फच्च ेPlural  

योटी Singular  

योदटमाॉ Plural 
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Split Infinitive 
 

This section doesn’t apply to Hindi. 

Subjunctive 
 

This section doesn’t apply to Hindi. 

Symbols & Non-Breaking Spaces 
 

This section doesn’t apply to Hindi. 

 

Syntax 
 

Hindi uses a different word order than English. The main differences are that verbs are placed at the end of the 

sentence (like in German) and that Hindi (like other Indian languages) uses postpositions instead of prepositions. 

Postpositions are like prepositions except that they are written after the noun. 

Declarative sentences 

 

English: Subject Verb Preposition Object => I go to the shop 

Hindi: Subject Object Postposition Verb => I shop to go > भैं दकुान जाता हूॊ। 

Imperative sentences 

 

English: Verb Negative Verb Adverb => Do not eat quickly 

Hindi: Adverb Negative Verb => Quickly not eat  > ज्दी ज्दी भत खाओ। 

Interrogative sentences 

English: Adverb Aux.Verb Subject Verb => What are you drawing? 

Hindi: Subject Adverb Verb => You what draw? > तुभ तमा ड्रॉ कय यहे हो? 

Verbs 
 

Hindi verbs are inflected with respect to gender of the subject (masculine, feminine), number of the subject 

(singular, plural), tense (present, past, future), action (perfect, imperfect, continuous), degree of respect (intimate, 

familiar, respect). Verbs are referred to in their infinitive noun form which ends in na. But in the US where Edit, 

Save, Delete etc words are used, the verb is used as first person, i.e. सॊऩादन कयें, सहेजें, हटाएॉ 
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Example: 

Continuous operations are usually expressed in English with a gerund, which should be translated into Hindi in 

passive voice. A translation of <searching image> as <छवि खोज यहा है> looks odd. It should be छवि खोजी जा यही है.  

 

Example Translation 

Saving file…. + र्फाइर सहेजी जा य ही है... 

- र्फाइर सहेज यहा है... 

Word Order 
 

The word-order in Hindi is SOV (Subject, Object and Verb). 

Example: Windows is unable to open this file. 

Windows इस ितत इस र्फाइर को खोरने भें असभथि है. 

Style and Tone Considerations 

This section focuses on higher-level considerations for audience, style, tone, and voice. 

Audience 
 

The English forms often do not distinguish between various uses of verbs (command, function name, description 

of an ongoing process, etc.). Find out what is really meant with the string, and translate accordingly. 

For commands, instructions, suggestions, etc., always use the personal imperative form, not impersonal forms, 

infinitives or deverbal nouns. 

Tone 
 

Use formal 2nd person to address the user. Normally, the pronoun आऩ  itself will not be needed, but its relevant 

possessive form should be used. 

Enter your name +अऩना नाभ मरखें. 
If you don't want to .. + मदद आऩ...नहीॊ कयना चाहत ेहैं... 
 

Use the formal 2nd person to address the system, without using the pronoun itself. 

Replace + प्रनतथथावऩत कयें  
 

Use continuous verbs refer to system status, ongoing processes, etc. 

Saving the file + र्फाइर सहेजी जा यही है 
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In questions to the user about actions of the system, start the question with "तमा…". 

Save the file? + तमा र्फाइर सहेजें? 

 

The same solution (to start the question with " तमा …") should be used when a question is phrased as a 

command to the user. When an option is phrased as a command to the user it should be used formal 2nd person 

(imperative mood). 

 

View the file now 

QUESTION 

+ तमा अबी र्फाइर देखें? 

OPTION 

+ अबी र्फाइर देखें. 

 

The first person may be used for personalized creatures like the Office Assistant. 

 

आऩ is the only form that can be used for “you” in written in Hindi. 

 

English Translation 

You are now connected to the Internet. अफ आऩ इॊटयनेट से कनेतट हैं. 

Style 
 

The style of writing should be simple and straight. There should be no confusion in the text. Hindi language 

should be written as it is written, rather than translating literally from the dictionary and on the basis of English 

sentences. It has been seen that there is an effort to copy the English style of making sentence. 

 

English Translation 

If you delete the file, you will loose all data. 
+ मदद आऩ र्फाइर हटात ेहैं, तो आऩका साया डटेा नष्ट हो जाएगा। 
- मदद आऩ र्फाइर हटात ेहैं, आऩ साया डटेा खो देंगे। 

Voice 
 

Avoid the impersonal as much as possible. Only in cases where the passive is used intentionally in English, i.e. 
the agent is not known or is not relevant, the term may be translated as impersonal in Hindi.  

 

The message has been sent + सॊदेश बेज ददमा गमा है. 
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Localization Guidelines 

This section contains guidelines for localization into Hindi. 

General Considerations 

The following sections will provide a set of guidelines for handling different elements while localizing UI and user 

assistance content.  

Please, make sure to always use current terminology and phrases for the product being localized by looking for 

the translations in the most recent version of the Microsoft terminology databases and other approved glossaries. 

Consistent use of Microsoft approved terminology in all localized products is one of the major factors in achieving 

the required quality for localized products. 

Abbreviations 

Common Abbreviations 
 

You might need to abbreviate some words in the UI (mainly on buttons or names of options) due to lack of space. 

This can be done in the following ways: 

In Hindi, there are no standardized abbreviations for words, so try to use the shortest available version of the 

word. Also, in the menus, try to use the imperative, to avoid longer words.  

  

List of common abbreviations: 

Commonly measuring units are abbreviated, such as ककभी for KM, and ककग्रा for KG. 

English Hindi  (full) Hindi (abbrev.) 

meter भीटय भी 
kilometer ककरोभीटय कक.भी. 
centimeter सेंटीभीटय सें.भी. 
millimeter मभरीभीटय मभ.भी. 
gram ग्राभ ग्रा 
kilogram ककरोग्राभ कक.ग्रा./ ककरो 
Liter रीटय री 
 

Some units of the International System of Units (usually these ones which are abbreviated as single capital letter) 

should be written in Latin, e.g. W (watt), V (volt), J (joule), Hz (hertz), kHz (kilohertz); other are written either in 

Latin or Hindi, e.g. kg as कक.ग्रा, cm as सें.भी. , etc. 
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Temperature is always measured using Celsius scale. All other temperature scales (e.g. Fahrenheit) must be 

recalculated into Celsius in the localized products. 

The standard way to display temperature is: x°С (x is the temperature, then goes the degree sign and then the 

capital Latin letter C, even in Hindi). Although in Hindi it may also be written as  x°सें (x is the temperature, then 

goes the degree sign and then सें, the abbreviation in Hindi) 

If the temperature is below zero, then the minus sign (–) is displayed before the temperature. However, if the 

temperature is equal or above zero, the plus sign (+) is optional and is rarely used, e.g. –273°C, 0°C, 25°C 

  

                Information units 

  

Units of information are often abbreviated. Always use the following: 

  

English Hindi   

KB kB 

MB MB 

bit bit 

bit/s bit/s 

Accessibility 
 

Localizers should use such a language that is simple, yet serious, easily understood, yet not cheap. Thats a tall 

order while translating, but then translating is a serious art. A software is used by all the segments of the society. 

It should be easily understood by all! It does not mean that most of the words should be transliterated. If we focus 

enough, there are always simple word to translate anything. The best example is, as we all know, the song that 

nobody can say whether it was originally written in English or Hindi. 

 

Example: We Shall overcome some day! O Deep in my heart! I do believe! 

Translation: हभ होंगे काभमाफ एक ददन! भन भें है विश्िास! ऩूया है विश्िास! 

Acronyms 

Acronyms are words made up of the initial letters of major parts of a compound term. Some well-known examples 

are WYSIWYG (What You See Is What You Get), OLE (Object Linking and Embedding), or RAM (Random 

Access Memory).  

 

Acronyms are generally not localized in Hindi. 
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Applications, Products, and Features 
 

Application/product names are often trademarked or may be trademarked in the future and are therefore rarely 

translated. Occasionally, feature names are trademarked, too (e.g. IntelliSense™). Before translating any 

application, product, or feature name, please verify that it is in fact translatable and not protected in any way. 

 

There are no specific rules for Hindi regarding trade marking of the applications, product, and features.  

Frequent Errors 
 

There are many common errors that are found in software localization in Hindi. They include using I for computer, 

Using verb form when creating titles, such as र्फाइर को सॊऩाददत कयना instead of र्फाइर का सॊऩादन. Please note 

though, that opening a document will still be translated as दथतािे़ि खोरना. Please see below some examples of 

frequent translation errors: 

 

Example Translation 

Display unavailable + प्रदशिन अनुऩरब्ध 

- अनुऩरब्ध को प्रदमशित कयें  
Sticking out your tongue (usually in fun) + जीब ददखाना (साभान्मत: भ़िाक भें) 

- आऩकी जीब को चचऩकाना (साभान्मत: भ़िाक भें) 
(Here without considering the actual meaning 

intended of the sentence, the sentence has been 

translated with dictionary in hand.) 

Glossaries 
 

Microsoft glossaries are to be used for localization. 

Fictitious Information 
 

Fictitious content is legally sensitive material and as such cannot be handled as a pure terminology or localization 

issue.  

Recurring Patterns 
 

This section doesn’t apply to Hindi. 
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Standardized Translations 
 

There are a number of standardized translations mentioned in all sections of this Style Guide.  In order to find 

them more easily, the most relevant topics and sections are compiled here for you reference: 

 

Grammar, Syntax & Orthographic Conventions 

Verbs 

Word Order 

Style and Tone Considerations 

 

Unlocalized Items 
 

Trademarked names and the name Microsoft Corporation shouldn’t be localized. A list of Microsoft trademarks is 

available for your reference at the following location: http://www.microsoft.com/trademarks/t-mark/names.htm. 

 

There are no words in Hindi that are written the same way as in English. There are words though that should be 

transliterated in Hindi as they are commonly used by general public. 
 

Using the Word Microsoft 
 

In English, it is prohibited to use MS as an abbreviation for Microsoft. 

The word Microsoft is to be left in English for the purpose of software localization. 

 

Example: Microsoft इसकी अनुभनत नहीॊ देता. 

Software Considerations 

This section refers to all menus, menu items, commands, buttons, check boxes, etc., which should be consistently 

translated in the localized product. 

 

Refer to http://msdn.microsoft.com/library/aa511258.aspx for a detailed explanation of the Windows user interface 

guidelines (English). 

User Interface 
 

Menu titles and menu items should be consistently translated in all localized products, the same US term should 

have identical translation in all localized applications.  

When possible, try to use the following combinations of word classes in menus: 

http://www.microsoft.com/trademarks/t-mark/names.htm
http://msdn.microsoft.com/library/aa511258.aspx
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Menu title Menu items Example 

A noun or deverbative noun 
A noun, deverbative noun or 

noun phrase 

On the Format menu: Font, 

Change Case..., Styles and 

Formatting... 

A noun or deverbative noun 
A noun, deverbative noun or 

noun phrase 
On the Table menu: Insert, 

Select, Sort..., Formula... 

A noun or deverbative noun A verb On the File menu: Close, Exit 

 

The word classes of the US term and the localized term do not have to coincide, i.e. please do consider the 

possibility of translating a verb as a noun or vice versa, if that improves the result. Adjectives are used relatively 

rarely and adverbs only in exceptional cases. 

Nouns and deverbative nouns should normally be in singular or plural nominative, verbs in informal 2nd person 

(singular) imperative mood. Verb in menu items followed by an ellipsis or right arrowhead should also be 

translated as informal 2nd person (singular) imperative mood. 

Menu titles should always contain only one word, since a two-word menu title would be undistinguishable from 

two single-word ones. 

In Hindi, the word order should normally reflect the order of user actions, even if it doesn't in English. 

Click Save in the File menu 
+ र्फाइर भेनू ऩय सहेजें क्तरक कयें 
− क्तरक कयें र्फाइर भेनू ऩय सहेजें 

  

The preferred action to be performed with menu titles and menu items is चुनें (select), even if the original ignores a 

similar recommendation given for English. 

Click Save in the File menu र्फाइर भेनू ऩय सहेजें क्तरक कयें 
Select Save from the File menu + र्फाइर भेनू ऩय सहेजें चुनें 

Messages 

Status Messages 

What is a Status Bar Message? 
 

A status bar message is an informational message about the active document or a selected command as well as 

about any active or selected interface item. Messages are shown in the status bar at the bottom of the window 

when the user has chosen a menu, a command or any other item, or has started a function. The status bar 

messages refer to actions being performed or already complete (for example in Outlook below). 

 



 

 
32 

 

 

Hindi Style in Status bar Messages 
 

In English, the status bar messages have different forms dependent on the information they must convey. In 

Hindi, menu and commands status bar messages should follow the format below. 

In Hindi menu status bar messages and commands status bar messages differ as shown in the tables. When the 

message is a direct instruction, the imperative mode is used, formal for addressing the user and informal for the 

system. Periods are used at the end of sentences in status bar messages, if they are full sentences. 
 

Name Hindi Name Category 
English Status Bar 

message 

Hindi Status Bar 

message 

Edit सॊऩादन menu Contains editing commands इसभें सॊऩादन आदेश हैं 
Copy to 

Folder... 

र्फो्डय भें प्रनतमरवऩ फनाएॉ 
menu 

Copies the selected items to 

a new location 

मह चमननत आइटभों की नए 

थथान ऩय प्रनतमरवऩ फनाता है 

New नमा command Creates a new document नमा आदेश फनाता है 

   Make object visible? ऑब्जेतट दृश्म फनाएॉ? 

   Word is converting the 

document. Press Esc to 

stop. 

Word दथतािे़ि को रूऩाॊतरयत 

कय यहा है। योकन ेके मरए Esc 

दफाएॉ। 
   Datasheet View डटेाशीट दृश्म 

   Done ऩूणि 
 

The importance of standardization 

In the US product you can often find messages that are phrased differently even though they have the same 

meaning. Try to avoid this in the localized <Hindi> version. Use one standard translation as in the examples 

below: 
 

English term Correct Hindi translation 

Press F1 to get Help भदद के मरए F1 दफाएॉ 
If you want Help press F1 
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To get Help press F1 

Not enough memory अऩमािप्त भेभोयी 
Insufficient memory 

There is not enough memory 

Save changes to %1? ऩरयितिनों को %1 भें सहेजें? 

Do you want to save changes to %1? 

Error Messages 

What Is An Error Message? 

Here is an example: 

 
 

Error messages are messages sent by the system or a program, informing the user that there is an error that 

must be corrected in order for the program to keep running. For example, the messages can prompt the user to 

take an action or inform the user of an error that requires rebooting the computer. 

 

Hindi Style in Error Messages 
 

It is important to use consistent terminology and language style in the localized error messages, and not just 

translate as they appear in the US product. 

The common error is using First Person Singular Number in Hindi for Error messages. As the concept of 

computer telling the user does not gel with the tone of the language, we cannot use the error message as if the 

computer is talking to the user. We should use passive voice instead for making such sentence. 

 

Example Translation 

Cannot save the document. + दथतािे़ि सहेजा नहीॊ जा सकता 
- दथतािे़ि सहेज नहीॊ सकता 
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Standard Phrases in Error Messages 

 

When translating standard phrases, standardize. Note that sometimes the US uses different forms to express the 

same thing. 

Same here for Hindi, whatever the form the US is using, we should use passive voice in the error message as 

that is the proper Hindi way of instructing and informing. The computer talking in the first person just does not get 

with the flow. 

 

Examples: 
 

English Translation Example Comment 

Cannot … 

Could not … 

ककमा नहीॊ जा सकता 
ककमा नहीॊ जा सका 

इस र्फाइर को हटामा नहीॊ जा 
सकता/सका n/a 

Failed to … 

Failure of … 

...कयन ेभें विपर  

...कयन ेभें विपरता 
 

 सहेजने भें विपर  n/a 

Cannot find … 

Could not find … 

Unable to find … 

Unable to locate … 

...ढूॊढा नहीॊ जा सकता/सका 

...ढूॊढने भें असभथि 
र्फाइर ढूॊढने भें असभथि n/a 

Not enough memory 

Insufficient memory 

There is not enough memory 

There is not enough memory 

available 

ऩमािप्त भेभोयी नहीॊ है ऩमािप्त भेभोयी नहीॊ है   n/a 

... is not available 

... is unavailable 

 उऩरब्ध नहीॊ है 

अनुऩरब्ध है 

 उऩरब्ध नहीॊ है 

अनुऩरब्ध है  
 n/a 

 

Error Messages Containing Placeholders 

 

When localizing error messages containing placeholders, try to find out what will replace the placeholder. This is 

necessary for the sentence to be grammatically correct when the placeholder is replaced with a word or phrase. 

Note that the letters used in placeholders convey a specific meaning, see examples below: 

%d, %ld, %u, and %lu means <number> 

%c means <letter> 

%s means <string> 
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Examples of error messages containing placeholders: 

"Checking Web %1!d! of %2!d!" means "Checking Web <number> of <number>". 

"INI file "%1!-.200s!" section" means "INI file "<string>" section". 

 

Same applies for Hindi also. A translator should first try to find out what exactly is the placeholder, because that 

will decide whether the sentence should use feminine form or masculine, or singular form or plural. The entire 

sentence may become wrong if this is not done. 

Keys 

 

The keyboard is the primary input device used for text input in Microsoft Windows. For accessibility and efficiency, 

most actions can be performed using the keyboard as well. While working with Microsoft software, you use keys, 

key combinations and key sequences. 

In English, References to key names, like arrow keys, function keys and numeric keys, appear in normal text (not 

in small caps). 

All keys used in Hindi are in their English format. There are no Hindi names given to the function keys or 

any other keys. 

Access Keys/Hot keys 
 

 

 

Sometimes, there are underlined or highlighted letters in menu options, commands or dialog boxes. These letters 

refer to access keys (also known as hot keys) that allow you to run commands, perform tasks, etc. more quickly. 
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There are no Hindi specific Access Keys. English Keys apply. 
 

Hot Key Special Options Usage: Is It Allowed? Notes 

"Slim characters", such as I, l, t, r, f 

can be used as hot key 

n/a n/a 

Characters with downstrokes, such 

as g, j, y, p and q can be used as 

hotkeys 

n/a n/a 

Extended characters can be used as 

hotkeys 

n/a n/a 

An additional letter, appearing 

between brackets after item name, 

can be used as hotkeys 

n/a n/a 

A number, appearing between 

brackets after item name, can be 

used as hotkey 

n/a n/a 

A punctuation sign, appearing 

between brackets after item name, 

can be used as hotkey 

n/a n/a 

Duplicate hotkeys are allowed when 

no other character is available 

n/a n/a 

No hotkey is assigned when no more 

characters are available (minor 

options only) 

n/a n/a 

 

Additional notes: n/a 

Arrow Keys 
 

The arrow keys move input focus among the controls within a group. Pressing the right arrow key moves input 

focus to the next control in tab order, whereas pressing the left arrow moves input focus to the previous control. 

Home, End, Up, and Down also have their expected behavior within a group. Users can't navigate out of a control 

group using arrow keys. 

Numeric Keypad 
 

It is recommended that you avoid distinguishing numeric keypad keys from the other keys, unless it is required by 

a given application. In case which keys to be pressed is not obvious, provide necessary explanations. 
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Shortcut Keys 

Shortcut keys are keystrokes or combinations of keystrokes used to perform defined functions in a software 

application. Shortcut keys replace menu commands and they are sometimes given next to the command they 

represent. In opposition to the access keys, which can be used only when available on the screen, shortcut keys 

can be used even when they are not accessible on the screen. 

There are no Hindi specific shortcut keys. English shortcut keys are used. 

 

Standard Shortcut Keys 
 

US 

Command 

US English 

Shortcut Key 

Hindi 

Command 

Hindi 

Shortcut key 

General Windows Shortcut keys 

Help window F1 भदद n/a 

Context-sensitive Help Shift+F1 प्रसॊग सॊिेदी भदद n/a 

Display pop-up menu Shift+F10 प्रदशिन ऩॉऩ-अऩ भेनू n/a 

Cancel Esc यद्द कयें n/a 

Activate\Deactivate 

menu bar mode 

F10 भेनू फाय कोड सकक्रम/ननक्ष्क्रम कयें n/a 

Switch to the next 

primary application 

Alt+Tab अगरे प्राथमभक अनुप्रमोग ऩय जाएॉ n/a 

Display next window Alt+Esc अगरी वि ॊडो ददखाएॉ n/a 

Display pop-up menu 

for the window 

Alt+Spacebar वि ॊडो के मरए ऩॉऩ-अऩ भेनू ददखाएॉ n/a 

Display pop-up menu 

for the active child 

window 

Alt+- सकक्रम चाइ्ड वि ॊडो के मरए ऩॉऩ-अऩ 

भेनू ददखाएॉ 
n/a 

Display property sheet 

for current selection 

Alt+Enter ितिभान चमन के मरए गुण ऩत्रक 

ददखाएॉ 
n/a 

Close active 

application window 

Alt+F4 सकक्रम अनुप्रमोग वि ॊडो फॊद कयें  n/a 

Switch to next window 

within (modeless-

compliant) application 

Alt+F6 (भोडयदहत-अनुऩारक) अनुप्रमोग के 

बीतय अगरी वि ॊडो ऩय जाएॉ 
n/a 

Capture active window 

image to the Clipboard 

Alt+Prnt Scrn सकक्रम वि ॊडो छवि को क्तरऩफोडि ऩय 
कैप्चय कयें  

n/a 
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US 

Command 

US English 

Shortcut Key 

Hindi 

Command 

Hindi 

Shortcut key 

Capture desktop 

image to the Clipboard 

Prnt Scrn डथेकटॉऩ छवि को क्तरऩफोडि ऩय कैप्चय 
कयें 

n/a 

Access Start button in 

taskbar 

Ctrl+Esc टाथकफाय भें प्रायॊब फटन ऩय जाएॉ n/a 

Display next child 

window 

Ctrl+F6 अगरी चाइ्ड वि ॊडो ऩय ददखाएॉ n/a 

Display next tabbed 

pane 

Ctrl+Tab अगरी टैब्ड ऩेन ददखाएॉ n/a 

Launch Task Manager 

and system 

initialization 

Ctrl+Shift+Esc कामि प्रफॊधक ि मसथटभ मसथटभ 

इननमशमराइ़िेमशन प्रायॊब कयें  
n/a 

File Menu 

File New Ctrl+N र्फाइर नई n/a 

File Open Ctrl+O र्फाइर खोरें n/a 

File Close Ctrl+F4 र्फाइर फॊद कयें  n/a 

File Save Ctrl+S र्फाइर सहेजें n/a 

File Save as F12 र्फाइर इस रूऩ भें सहेजें n/a 

File Print Preview Ctrl+F2 र्फाइर वप्र ॊट ऩुनयािरोकन n/a 

File Print Ctrl+P र्फाइर वप्र ॊट कयें  n/a 

File Exit Alt+F4 र्फाइर फाहय n/a 

Edit Menu 

Edit Undo Ctrl+Z सॊऩादन ऩूििित कयें  n/a 

Edit Repeat Ctrl+Y सॊऩादन दोहयाएॉ n/a 

Edit Cut Ctrl+X सॊऩादन काटें  n/a 

Edit Copy Ctrl+C सॊऩादन प्रनतमरवऩ फनाएॉ n/a 

Edit Paste Ctrl+V सॊऩादन चचऩकाएॉ n/a 

Edit Delete Ctrl+Backspace सॊऩादन हटाएॉ n/a 

Edit Select All Ctrl+A सॊऩादन सफ चुनें n/a 

Edit Find Ctrl+F सॊऩादन ढूॊढें  n/a 
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US 

Command 

US English 

Shortcut Key 

Hindi 

Command 

Hindi 

Shortcut key 

Edit Replace Ctrl+H सॊऩादन फदरें n/a 

Edit Go To Ctrl+B सॊऩादन जाएॉ n/a 

Help Menu 

Help F1 भदद n/a 

Font Format 

Italic Ctrl+I भदद n/a 

Bold Ctrl+G भदद n/a 

Underlined\Word 

underline 

Ctrl+U भदद n/a 

Large caps Ctrl+Shift+A n/a n/a 

Small caps Ctrl+Shift+K n/a n/a 

Paragraph Format 

Centered Ctrl+E कें दद्रत n/a 

Left aligned Ctrl+L फाएॉ सॊयेखखत n/a 

Right aligned Ctrl+R दाएॉ सॊयेखखत n/a 

Justified Ctrl+J सभामोक्जत n/a 

Document Translation Considerations 

Document localization may require some specific considerations that are different from software localization. This 

section covers a few of these areas. 

While translating a document, the flow of the text and simple, clear language is necessary. Many times the words 

used are archaic and cannot be understood by common users. Sometimes, a sentence is literally translated using 

the format of English text. Instead, Hindi sentence should be written as Hindi is written and should not be based 

on English. 

 

Example Translation 

You are about to exit the setup wizard + आऩ सेटअऩ वि़िाडि से फाहय ननकरने िारे हैं 
- आऩ सेटअऩ वि़िाडि से रगबग फाहय ननकरने िारे हैं 

If you think I should, I guess I will + मदद आऩको रगता है कक भुझे मह कयना चादहए, तो 
शामद भैं ऐसा ही करूॊ गी 
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Example Translation 

- मदद आऩका भानना है कक भैं ऐसा करूॊ  तो, भैं आशा कयती 
हूॊ कक भैं ऐसा करूॊ गी 

Titles 
 

In English the titles for chapters usually begin with "How to …" or with phrases such as "Working with …" or 

"Using …". In the Hindi version of Microsoft documentation, titles should generally be created using a noun 

instead of in verb format. 

 

Example Translation 

Managing account + खात ेका प्रफॊधन 

- खात ेको प्रफॊचधत कयना 
How to delete the information + जानकायी को कैसे हटाएॉ 

- जानकायी को हटाने की विचध 

Copyright 
 

Copyright protection is granted to any original work of authorship fixed in any tangible medium of expression from 

which it can be perceived, reproduced, or communicated. 
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